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WARNING

Do NOT look directly at the sun through your binoculars.
Doing so may cause permanent eye damage.

NOTE: To reset the camera if you experience problems or if the display becomes 
unresponsive, remove the batteries for at least one minute, then re-install them. 
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Congratulations on your purchase of the Bushnell ImageView® binocular! 
The Bushnell ImageView binocular takes the technology of digital 
photography and combines it with a high-quality compact binocular.  
This allows you to observe sporting events, wildlife, scenic vistas or 
anything you would normally use a binocular for, and then save the 
image in a built-in attached digital camera.  You can then download these 
images to your computer and e-mail them to your friends and family, 
print out the pictures, or save them in a photo album for future use. 
Before using the product, please read the instructions contained in this 
manual and take time to familiarize yourself with the different parts and 
features of the product.
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CAMERA PARTSSetup and Basic Operation
1.	 The camera is powered by two AAA alkaline, lithium, or NiMh batteries (not 

included). Insert batteries into the compartment, with the springs in contact with 
the negative (flat) end of each battery. A power meter on the left center of the 
display indicates battery condition.

2.	 Insert an SD card ("upside down" with metal contacts facing up) in the slot if greater 
storage is desired. You may use SD cards (not MMC cards) up to 8 GB capacity. As 
the camera has no internal memory, it cannot be operated without an SD card. If 
no card is inserted and the power button is pressed, the display indicates “NSd” (no 
SD) (see “Parts Guide”), the memory card icon blinks, and the camera shuts down. If 
this happens, insert a card, then power on again. 

3.	 Press and hold the MODE button until the camera turns on. The camera will turn 
off automatically after about one minute if no buttons are pressed. Note: when the 
camera is connected to a computer via the supplied USB cable, the camera will power 
on automatically, and draw power from the computer with no battery drain.

4.	 Hold the ImageView steady and press SNAP to take a picture (or start/stop 
shooting a video, when the camera is in video mode). The camera focus is preset 
to take sharp photos from appoximately 35 feet to infinity.

5.	 When using a tripod, you can help avoid the effects of camera shake by plugging 
the supplied remote shutter release into the jack next to the SD card slot, and 
using the button on the remote rather than SNAP to take photos.
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Setting Date & Time/ Using the Operational Modes
The ImageView will imprint the date and time in the bottom right corner of your photos. 
To set the current date and time, after turning on the camera, press and hold both the 
MODE and SNAP buttons at the same time, until the display begins to flash. The display 
now shows the last two digits of the year. Press the MODE button to move the cursor to 
the second digit if necessary. Press the SNAP button to advance the digit to the current 
year ("10" for 2010, etc). Then press MODE to go to the next number, which is the month. 
Again, use SNAP to change this to the current month. Following the month display is: 
date, hour (24hr format), and minute-continue to set these following the same process 
using the MODE and then SNAP buttons. When you have completed all of the date/time 
settings, the display will stop flashing and return to normal.  Note that you will need to 
reset the date/time after replacing batteries.

Your ImageView is already setup to produce high quality results right out of the box, 
and it is not necessary to use the MODE settings and make any changes to get good 
results by simply pressing the SNAP button to take photos. However, as you might want 
to shoot a video clip, delete one or more previous photos, or explore other options, 
we recommend you review the available mode options listed on the following pages. 
Briefly pressing the MODE button will step through these operational modes in the 
listed order, and you will see the icon for each mode along with its current setting on 
the display. Use the SNAP button to select the desired setting for any mode. If you make 
no changes, and the SNAP or MODE button is not pressed within 5 seconds, the camera 
will return to normal operation and display. 
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Mode Icon Settings Description

Video Video 
Camera

OFF, High 
(640x480 
pixels per 
frame, 29 fps), 
Low (320x240 
pixels)

Select "Hi" (recommended) or "Lo" video 
resolution instead of "OFF" to put the camera in 
video mode. Wait a few seconds for the camera to 
automatically return to the normal display, then 
begin shooting by pressing SNAP. The counter 
will show the elapsed time while recording the 
video clip. Press SNAP again to stop shooting. The 
counter will advance by one, indicating the video 
file has been saved. Return to the video mode 
setting and select OFF to reset the camera to still 
photo mode. 

Quality Hq or Lq High, Low Select "Hi" (recommended) or "Lo" quality to 
choose the amount of file compression, which 
affects the size of the photo file. "Lo" allows more 
photos to be stored in memory, but at reduced 
quality.

Resolution Hi or Lo High (2.0MP*), 
Low (1.3 MP)
*via software 
interpolation

Select "Hi" or "Lo" resolution, based on your 
preference for more detailed photos (Hi) or being 
able to take a greater number of photos (Lo).

Using the Operational Modes  (Bold indicates default settings)
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Mode Icon Settings Description

Line 
Frequency

60 or 50 60 Hz, 50 Hz Set to match the AC power frequency (cycles) of 
your country. This ensures that stills and videos 
shot under fluorescent lighting appear normal.

Continuous CT OFF, 3, 5 Select 3 or 5 frames to shoot a rapid series of 
photos instead of a single frame when SNAP is 
pressed (in normal still photo mode). To cancel, 
enter this mode again and select OFF.

Memory 
Access

MEM Sto (USB Mass 
Storage), PC 
(USB Camera)

Select "Sto" to access the SD card files when the 
camera is connected to a computer with the USB 
cable. "PC" allows the camera to be used as a live 
USB/PC camera (note that the 8x magnification 
and lack of close focus capability limits usefulness 
in most size rooms.)

Delete Last LSt+Trash 
Can

None-press 
SNAP to delete 
the last photo 
or video

Select this mode and press SNAP to delete only 
the last photo or video you took. The counter will 
go down one number.

Using the Operational Modes
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Mode Icon Settings Description

Delete All ALL+Trash 
Can

None-press 
SNAP to delete 
all photo and 
video files

Select this mode and press SNAP to erase the 
entire memory contents (the counter resets to 
zero). Use this after downloading your files, to 
clear the memory so you can take new photos. If 
"Delete All" is selected accidently, simply wait a 
few seconds and the camera will return to normal 
operation.

Format FOr+Trash 
Can

None-press 
SNAP to 
format card 
or internal 
memory

If you are using a new SD card, or one previously 
used in other devices, we recommend you select 
Format and press SNAP before you start taking 
photos, to the card is setup with the correct data 
file system for this camera. Note that formatting a 
card  erases its contents-please be sure you have 
backed up any previous files first.

Self-Timer Clock OFF or On Photo is taken after a 10 second delay when SNAP 
is pressed (in normal still photo mode.) This can be 
used to avoid accidently shaking the camera when 
the SNAP button is pressed. If the remote shutter 
cable is available, it should be used instead of the 
self timer when the camera is tripod mounted. 
The timer automatically cancels after use.

Using the Operational Modes
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Using the ImageView with Your Computer
1.	 The camera will be recognized as a USB mass storage device, which means no special 

drivers are required for all operating systems later than Windows 98 (Me, 2000, XP, 
Vista, and Windows 7.) Mac OS 9 and OSX are also compatible. 

2.	 If you have a computer OS as listed above that is USB mass storage compliant, a 
new disc icon will appear in Windows Explorer (under “My Computer”) as a new 
“Removable Disc” after plugging in the USB cable from the Imageview. Mac users will 
see the new disc device appear on their desktop. Clicking on the new disc icon will 
show the contents, a folder named “DCIM.” The image folder inside this contains your 
photos, stored as JPEGs (.jpg file format). They may then be viewed, edited, renamed 
and saved using any photo or graphics software that accepts .jpg files. 

3.	 After you have copied or opened and saved the photo files to your computers hard 
drive, you may disconnect the Imageview camera (NEVER disconnect the camera 
while files are still being transferred to your computer.) Before disconnecting, you 
should “eject” or stop the "removable disc" representing the camera to avoid an error 
message (not necessary with Windows XP or later OS). 

4.	 See the following pages for full step by step instructions to download your photos.

System Requirements
Operating System: Windows® 2000/ME/XP/Vista/Windows 7 
(Windows 98 is not supported) or Mac OS 9 / OS X
Internal USB Port
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1.	 Connect the supplied cable to the ImageView’s USB port, then directly to a main 
USB port on your computer-do not use front panel/keyboard USB ports or unpow-
ered “hubs”.

2.	 The LCD display will indicate “STO”, and the ImageView will be recognized as a 
standard “USB Mass Storage” device. This means that the camera files can be 
easily viewed, edited, or copied to your hard drive, just as if they were stored on 
an external hard drive or a CD-ROM. (Note for Mac users: you may need to select 
"STO" memory access and plug in the ImageView while its LCD still displays 
"STO" for it to appear on the Mac desktop as an "Untitled" disk. See "Using the 
Operational Modes")

3.	 (This step is not required with recent Windows operating systems, simply use the 
options in the pop-up window to view, copy or edit your photos). Open My Computer 
or Windows Explorer. The camera will be seen as a new “Removable Disk” with 
an unused drive letter assigned to it. Double click this new “Disk” icon, open the 
“DCIM” folder inside, then the folder(s) inside that (“100MEDIA” ,etc). Your photos/
videos are the files inside-they have the prefix “SUNP” followed by a 4-digit 
number, as seen earlier on the camera’s display when you review photos. Single 
clicking any file should show a small preview image.

4.	 Click “Edit>Select All” (or click on one photo, contol+click to select multiple 
photos), then “Edit>Copy to Folder” (in Windows menus). Select an existing folder 
on your hard drive, such as “My Pictures”, or create a new folder (“Hawaii Vacation”, 

Downloading the Photo/Video Files
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Downloading the Photo/Video Files
etc), then click “OK” to transfer copies of the photo files you want.

5.	 After the photos are transferred to your hard drive, you can disconnect the camera. 
Windows 2000 may produce a screen warning that you have disconnected a USB 
device without stopping or ejecting the “disk” first (your photo files will not be 
harmed). If so, check the box that adds an icon to your system tray or taskbar.  Then 
next time you finish transferring photos, you can click that icon first, and “Stop the 
USB Mass Storage Device” before disconnecting the camera. (On Mac computers, 
drag the “disk” that appeared on your desktop when the camera was connected into 
your Trash to “eject” it before disconnecting.)

6.	 You’re now ready to open the photo files in any photo editing software. Just use 
File>Open and go to the folder where you stored the photos earlier. It is also 
possible to open and work with your photos directly from the ImageView while it 
is still connected. If you choose to work this way, from a connected camera, be sure 
that you save the photo (when you are done editing) to your hard drive, and not the 
camera’s memory or card. If you are new to photo editing on a computer, consult 
your software’s Help menu for tips on using its features. Along with adjusting the 
brightness, contrast, sharpness and color of your photos, you can resize the photo 
to fit the paper if you are printing, or save a smaller, low or medium resolution 
version for email or inserting into documents. When you are ready to save your 
edited file, you may want to use “Save As” and give it a more descriptive name than 
“SUNP___”. Doing this also preserves the original file as a backup to reopen and re-
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Downloading the Photo/Video Files
edit later.  Make sure you have successfully transferred all the photos you wanted 
to save before using “Delete All” on your camera to make room for new images.

Binocular Instructions
Your Bushnell binocular is a precision instrument designed to provide many years 
of pleasurable viewing. This portion of the booklet will help you achieve optimum 
performance by explaining how you can adjust the binocular to your eyes, and how 
to care for this instrument. Read the instructions carefully before using your binocular.

Adjusting the Binocular IPD
The distance between the eyes, called “interpupillary distance,” varies from person to 
person. To set the hinge for your personal IPD:

Hold the binocular in the normal viewing position, with a firm grip on each side. 
Move the barrels closer together or further apart (Fig. 2) until you see a single circular 
field. Always re-set your binocular to this position before using.

Fig. 2   Interpupillary Distance



15

Binocular Instructions

Focusing/Diopter Adjustment
As individual eyesight varies from one person to another, your binocular has an 
adjustable diopter feature which allows you to fine-tune the binocular to your vision. 
To set the diopter and focus the ImageView's binocular:

1.	 Adjust the hinge for your interpupillary distance as described 
in “Adjusting the Binocular IPD”. 

2.	 Set the “diopter adjustment” to zero (Fig. 3).
3.	 Keep both eyes open at all times.
4.	 Using a lens cover or your hand, cover the objective (front) lens 

of the right side of the binocular.
5.	 Using the center focus wheel, focus on a distant object with 

fine detail (e.g., brick wall, tree branches, etc.), until it appears 
as sharp as possible through the left side of the binocular.

6.	 Uncover the objective lens on the right side, cover the left 
objective lens, then view the same object.

7.	 Turn the “diopter setting” adjustment ring, until the object is sharp for your right 
eye. Caution should be used as over turning or forcing the diopter eyepiece may 
damage the binocular.

8.	 Your binocular should now be adjusted for your eyesight. Focus at any far or near 
distances can now be attained simply by turning the center focus wheel. Make a 
note of your diopter setting for reference.

Binocular Instructions

Fig. 3   diopter adj.
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Eyecups
The ImageView binocular is fitted with rubber roll-down eyecups designed for your 
comfort and to exclude extraneous light. If you wear glasses, roll down the eyecups. 
This will bring your eyes closer to the ocular (eyepiece) lenses, so you can more easily 
view the entire image without any cutoff.

Storage, Cleaning And General Care
Your Bushnell ImageView will provide years of trouble-free service if it receives the normal 
care you would give any fine optical instrument. The Imageview is not waterproof, and 
should not be exposed to any source of moisture. Water damage is not covered by the 
warranty.

1.	 When storing your ImageView binocular, put the eyecups in their "up" position. This 
avoids excessive stress and wear on the eyecups (if left in the down position).

2.	 Avoid banging and dropping.
3.	 Store in a cool, dry place.
4.	 WARNING: Looking directly at the sun with your binocular can cause permanent eye 

damage.
5.	 Never expose your ImageView binocular to any type of excessive liquid or fluid, as it 

is not water/fogproof.
6.	 Take the batteries out of your ImageView if you are not going to use it for a long 

period of time. 

Binocular Instructions
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CLEANING
1.	 Blow away any dust or debris on the lens (or use a soft lens brush.)
2.	 To remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular 

motion. Use of a coarse cloth or unnecessary rubbing may scratch the lens surface 
and eventually cause permanent damage. A “microfiber” cleaning cloth (available at 
most photo dealers) is ideal for the routine cleaning of your optics.

3.	 For a more thorough cleaning, photographic lens tissue and photographic-type 
lens cleaning fluid or isopropyl alcohol may be used. Always apply the fluid to the 
cleaning cloth – never directly on the lens.
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Your Bushnell® product is warranted to be free of defects in materials and workmanship for two years after the date of purchase. 
In the event of a defect under this warranty, we will, at our option, repair or replace the product, provided that you return 
the product postage prepaid. This warranty does not cover damages caused by misuse, improper handling, installation, or 
maintenance provided by someone other than a Bushnell Authorized Service Department.

Any return made under this warranty must be accompanied by the items listed below:
	 1)	 A check/money order in the amount of $10.00 to cover the cost of postage and handling
	 2)	 Name and address for product return
	 3)	 An explanation of the defect
	 4)  Proof of Date Purchased
	 5) 	 Product should be well packed in a sturdy outside shipping carton, to prevent damage 
		  in transit, with return postage prepaid to the address listed below:

	 IN U.S.A. Send To: 			   IN CANADA Send To:	
	 Bushnell Outdoor Products			   Bushnell Outdoor Products
	 Attn.:  Repairs				   Attn.:  Repairs
	 9200 Cody				    25A East Pearce Street, Unit 1
	 Overland Park, Kansas 66214			   Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable warranty information. 
In Europe you may also contact Bushnell at:  			   Bushnell Germany GmbH 
							       European Service Centre 
							       Mathias-Brüggen-Str. 80 
							       D-50827 Köln 
							       GERMANY 
							T       el: +49 221 995568-0

							       Fax: +49 221 995568-20

This warranty gives you specific legal rights. 
You may have other rights which vary from country to country.

©2011 Bushnell Outdoor Products

TWO-Year LIMITED WARRANTY



FCC Note:
this equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. these limits are designed to provide reasonable protection 
against harmful interference in a residential installation. this equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee 
that interference will not occur in a particular installation. if this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off  and on, the user is encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.
• increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit diff erent from that to which the receiver 

is connected. 
• Consult the dealer or an experienced radio/tV technician for help.

the shielded interface cable must be used with the equipment in order to comply with the limits for 
a digital device pursuant to Subpart B of Part 15 of FCC Rules.

Specifi cations and designs are subject to change without 
any notice or obligation on the part of the manufacturer. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 
Mac and Mac OS are trademarks of Apple inc., registered in the U.S. and other countries. 



©2011 Bushnell Outdoor Products

For further questions or additional information please contact:

Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214

(800) 423-3537  •  www.bushnell.com


